
 

  

Merrill Communications LLC 
d/b/a Merrill Corporation 

Exhibit 1005 pt 2



 



 
Paey

3



Storing data 39 

Knowing when to use multiple tables 43 

Understanding the one-to-many relationship 45 



Understanding Databases 

M ost people are accustomed to working 
with information, which is data that's 
organized into some meaningful 

form. You probably can recognize the information shown in Figure 2.1 as an invoice. You 
can find the customer's name and address, the products that person ordered, and just 
about any other information you might want simply by looking at the invoice. The invoice 
as a whole presents business information-namely, what happened in a transaction-by 
meaningfully drawing together various related items of data. 

Suppose you want to store all your invoices on the computer. You might consider 
buying a scanner and scanning each invoice into a computer file. Later, you could dis
play a copy of the invoice on the screen and print it. You wouldn't even need a database 
management system; all you would need is a scanner and a simple graphics program. 

Wh~ Store Data~ 
The problem with the scanner approach is that all you can do is retrieve, view, and 
print the invoices. You can't analyze or reformat the data on the invoice. For instance, 
you can't print mailing labels, envelopes, or form letters for all your customers. You 
can't analyze your orders to view overall sales. Why not? Because the computer doesn't 
have the eyes or brains it takes to look into the invoice and pull out certain types of 
information. Only you can do that job because you do have eyes and a brain. 
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MjlijQ;IIJM 
A sample 

printed invoice. 
You probably 

can find what
ever informa
tion you need 

about the trans
action on this 
sheet of paper 

because you 
recognize 

different types 
of information 

(name, address, 
products, order 
total) based on 

their context. 

L 

Invoice 

1~· & K ,\'portiltJ.: ( iood,· 

1337 W'e1t -lltl1 S!J 'eel 

Frh/h•J•. N< ' 28 ]28 

1\I'_.J 

Phoue (711./) 555-1555 Fox: tlfl./i 555-1 55(1 

ltrl'oke Date 8/31 / 1)5 Contact Nflme 

Order ID /fl PO Number 

Order Date :!/II!J5 Term.\· 

Ship To: 

/VorldWid~· lf'id;.:e!\' 

187 .'•lu!Ji1//.: !.n 

/Joi.\'t' , /1) 83 720 

CJ.\>1 

(l{}.''U 555-S()Vl 

Shi1lcy (jje\'l 

78 

Net /Odo.vs 

Bill To: 

Cu.\·tomer 1 D 

SllipDute 

Stripping 
Met/Juri 

Wo1•/dWide Whlxets 

187 S1d{olk Ln 

JJois..: , I D 83 720 

USA 
(208) 555·80')7 

1/ };1)5 

Fcdl!l'al 
E.\plt',li.~' 

Product 10 Product Name 
Blll ia(d balls 

Quantity 
~ 

Unit Price Discount Line Total 

Foolball 

S12 7 .<15 0 00% $254 90 

S565 

Subtotal 

Freight Charge 

Sales Tax 

Order Total 

Total Payments 

Total Duo 

000% 

You 'll never go IVJ ung wilh nur p1 nduc/s nlong! 

$566 

S260 56 

$2 00 

JO.OO 

S262 56 

S1000 

S252.56 

• 

Flexibilitij Is the Goal 
[f you want the a . x.lb llity to dl'ir lay, print, and analyze your information in wha tever 
fruma t you wish, you fir t need t l re k lown that information into mall units of data. 

For exam pi , a pers n' last name is one unlt of data. Tl1at p .r- n' zip code I another. 
The name of one pr duct tlle cust m r purchased is another unit of data, a11d s f rth. 
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After breaking the information into discrete units of data, you can use a database man
agement system, such as Access, to analyze and present that data in any way you wish. If 
each person's surname is a discrete unit of data, for example, you can tell Access to alpha
betize your customers by name or to find the order that Smith placed yesterday. 

You can put the individual units of data into any format you wish-for example, 
mailing labels, envelopes, or invoices. 

You Use Tables to Store Data 
In Access, you must break all your information into data that's stored in tables. A table 
is just a collection of data that's organized into rows and columns. You can put any 
information that's available to you into a table. 

Let's forget about invoices for a moment and focus on storing information about 
customers. Suppose you have a Rolodex or card file containing customer names and 
addresses as shown below. For each customer you maintain the same pieces of infor
mation-name, address, and so on. 

Mr. Andy A. Adams 
123 A St. 
San Diego, CA 91234 

(619) 556-9320 

How can you break down the information on this Rolodex into raw data that's neatly 
organized as a table? Easy. Just make a column for each data element, such as last name 
or state, and then list the corresponding data elements for each customer in rows, as 
shown in Figure 2.2. 

0 

·~ 
~ 
c 
< 
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•:zaw••• 
Names and 
addresses, 

which might 
once have been 

on Rolodex 
cards, orga

nized and typed 
into an 

Access table. 

I Shirley 
'Susi! d 
Amta 
Sheila 
Andy 
H nley 

1137 ~:uffolh Ln 
s( hutnack :'817 lvlillon D1 
.A.darns 53513 E 20th :0::1 
:~turnit1 ~1i F1 0 . E:o::< 23~lB 1 
/\darn s 87 Polk :::t 
Strappn 1a11 27•13 Bering St 

• 

Pho11e 
{3G7)555-4880 

Borse (206)555.SIF7 
Alb11querque 871 10- (505)555-5939 
Santa Fe NM 87110-3857 (~5)555-1232 

San Diego I CA 92576·4747 (619)555-4725 
San Fram;is~ CA ~14'1 17- (415)51".:>5-5938 
Anchorage AK 99500- {907)555-7584 

~I 
NU 

Terminologu Time 
Now is as good a time as any to get so me te rminology out of the way so that we ca n talk 

abou t tables :md databases more precisely. Here a re four terms you'll see often as you 

work with any da tabase management system: 

Table 1\ collection of d:tt:l organized into rows and columns. 

Field A single unit (or column) of information in a table. The sample table in Fig

ut'c 2.2 consists of fidds named Mr/Mrs, FirstName, L<~slNamc, Address, City, State, 

PostaiCode, and Phone, as you G ill Sl'L' hy looking across the top of the table. 

Record The set of all datcl fields for one row of the ta ble. The sample table in Fig

urL' 2.2 contain s seven filled records: one for a customt•r named Andy Adams, 

another for /\nita Adams, ~1ml so forth . 
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Database Contrary to what some people think, a database is not a table. A database 
is a collection of all the tables and other objects (such as forms and reports) that you 
use to manage data. 

We'll tell you more about why a database might contain several tables later in this 

chapter. 

The More Fields, the Detter 
Looking back at Figure 2.2, you may be wondering why we bothered to break the infor
mation into so many different fields. Isn't using the three fields Mr/Mrs, LastName, and 
FirstName a little excessive? 

Not really, because organizing the data into separate fields now will make it easier to 
arrange the data in a meaningful form later. Here are some ways to arrange the data in the 
first record of the table shown in Figure 2.2: 

Mr. Andy Adams 
Mr. Adams 
Adams, Andy 
Dear Andy: 
Andy Adams 
Yo Andy! 

As you'll see in later chapters, you can rearrange the table columns in any order you 
wish, and you can use forms and reports to organize table data into any format. 

Wh~ Use Multiple Tables? 
Earlier we said that a database can contain many tables. So now you may be wondering 
why you'd want to put more than one table into a database. The simple reason is that 
it's easier to manage data if all the information about a particular subject is in its own 
table. For example, if you're designing a database to track membership in an organiza
tion, you might create separate tables such as these: 

All Members 
Committees 
Payments Made 
Your Company or Organization 
Membership Types and Dues 
Committee Members 
Payment Methods 



44 CHAPTER 2 • UNDERSTANDING DATABASES 

If you're using Access to manage orders for your company's products, you might use 
these tables: 

Customers 
Order Details 
Payment Methods 
Products 
Employees 
Orders 
Payments 
Shipping Methods 

Remember that these tables are suggestions only. Access really doesn't care what type 
of data you put into tables. All that matters is that you find a way to break the infor
mation you need to manage into the tabular fields-and-records format. 

The Database Wizard and Table Wizard can create many types of tables for you 
automatically. These Wizards break your database into tables and divide your 
tables into separate fields with only a small amount of guidance from you. The pro
cess is so fast and painless that you'll be creating complete databases in no time. 
You'll learn more about these Wizards in Chapters 3, 5, and 6. 

When to Use One Table 
Until you get the hang of how to structure a database, deciding whether data should go 
into one table or several tables is a bit difficult. But this general rule of thumb always 
applies: If a one-to-one correspondence exists between two fields, put those fields into 
the same table. 

For example, it makes sense to put all the My Customers information in one table 
because there's an exact one-to-one dependency between fields. That is, for every one 
customer there's one customer name, one address, one city, and so forth. 

When to Use More Than One Table 
just because you put all your customer information into a single table doesn't mean 
you should put all the information for an entire business in one table. After all, you 
wouldn't put all the information for your customers, orders, products, and so forth on 
one Rolodex card. Likewise, you wouldn't put all that information into a single table. 
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A better plan is to put customer data in one table, product data in another, and order 
data in yet another because no one-to-one correspondence exists among these catego
ries of information. Any one customer might place many orders, and any order might 
be for many products. So here we have some natural one-to-many relationships among 
the subjects of your tables. 

The One-to-Man~ Relationship 

WilflU;If#M 
A one-to-many 

relationship 
between orders 
and customers 
(any one cus
tomer might 
place many 
orders). The 
Customer ID 

field in the My 
Orders table 

identifies which 
customer 

placed each 
order. 

The one-to-many relationship describes a situation in which every item of data in a table 
may be related to many items of information in another table. For example, each one 
of your customers might place many orders (at least you hope so!). Therefore, it makes 
sense to put all your customer data in one table and data about the orders they place in 
another table, as shown in Figure 2.3. (In the figure, only the first few fields from each 
table are shown. Additional information about customers and orders is scrolled off 
the screen.) 

If we do use more than one table, however, we also need a way to determine exactly 
which customer goes with each order. And that's where the primary key field comes in . 

~ hlocrosoft Access 1!1!';1 13 
E!le !;:dlt :i!ew [nsert Fwmat B,ecords !ools l'{lldow l:felp 

~ ~ ·I ~ i ~ 1:9. ~ I Jt ~ e, :{/ion ~ •I ~l u 1 ~ 1m \~· 

Dr. 

Anrta Adams 
Sheila Stumingi 

1Andy i\dams 
Hanley Strappman 

7 • Itt I~ J of7 

RNM Associates 
WorldWide Wodgals 
Univers~y of the Elite 
ABC Corporatoon 

jWorldWide Widgets 
Reese Clinic 

Boise 
817 M11ton o,, Albuquerque 

5356 E 2Dt h St Santa Fe 
I P 0 Box 23981 
87 Polk St. 

· 27 43 Bering St. Anchorage 
~I I 

• 

0 
~ 
-~ 
Ql 

> 
0 
c: 
<( 
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The Primary Key Field 
The primary key field in a table uniquely identifies each record in that table. In the My 
Customers table shown in Figure 2.3, only one customer has the ID 4. Even if that table 
has other people named Shirley Ujest from other cities, only one customer has the ID 4. 
When we added the Customer ID field to the My Customers table we made it the 
primary key so that Access would make sure that no two people were given the same 
Customer ID number. 

Your social security number is an example of a primary key field because it uniquely 
identifies you on the government's databases. Even though other people in the 
country may have the same first, last, and even middle name as you, nobody else 
in the country has the same social security number. 

Notice too that the information in the My Orders tables is compact. For example, 
the customer's honorific, first name, and last name aren't repeated in the My Orders 
table. All the My Orders table needs to get that information is the customer's unique ID 
number. Access can then dig up any information about that customer just by looking 
up the corresponding record in the My Customers table. 

It's Easier Than It looks 
This business of breaking down information into data in separate tables confuses many 
beginners, and it has been known to end the careers of many budding database design
ers. But there's no need to throw in the towel if you're feeling uneasy. As you'll see in 
the following chapters, Access will help you figure out how to break your information 
into related tables, and it will help you define primary key fields for the tables. So all 
you really need to understand now is that 

• Your database is likely to contain several tables. 
• Your tables will use a primary key field to uniquely identify each record in the table . 

Where to Go from Here 
Remember that the reason for breaking down information into raw data is to give you 
the flexibility to analyze and display data any way you wish. Once your data is orga
nized into a database on disk, there's no limit to the type of information you can glean 
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from that data (Chapters 10 through 14 will explain more about analyzing and display
ing data). 

Where should you go next in this book? Here are some suggestions: 

• To learn the basics of Access in a hurry, try the hands-on practice in Chapter 3. In 
just minutes, you'll create a fully functional database-complete with data, forms, 
reports, and a push-button menu for managing it. 

• To get an idea about how Access and the other programs in the Microsoft Office 
suite can work together, check out Chapter 4. 

• To find out how to create a database for storing your tables, proceed to Chapter 5. 
(All tables must be stored in a database.) 

• To find out how to create tables for data that's all on paper and not on any com
puter, see Chapter 6. 

• To learn how to manage data that's already on the computer in some database format 
(such as Access, dBASE, Paradox, SQL, text, HTML, and so forth), jump to Chapter 7. 
You may be able to use that data without creating your own tables from scratch. 
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Recess in an Evening 

his chnptcr is a hands-on guided tour 
of Access dataha · -s ln s ven qu i k les

ns. Th e lessons probably won' t 
make you an Access guru, but they'll give you both the big picture of what Access is all 
about and direct experience in using its most important features . 

During these lessons, you'll use Wizards to create an application for managing infor
mation about your contacts complete with data, form s, reports, and a push-button 
Switchboard form that makes the database a cinch to use. You 'll also learn how to enter 
data, sort it in alphabetical order, find specific information, customize forms and 
reports, isolate specific information by using queries, and tweak the descriptions that 
appear on the Switchboa rd form. 

Access offers many automated Wizards to help you set up new databases, tables, 
forms, reports, and queries in a flash . We strongly encourage you to use Wizards, 
rather than from-scratch methods, to create most new objects, especially if you're 
new to Access or to database management. Once an object exists, you can tweak 
it as necessary. This "create it with a Wizard and then refine it" approach is sure to 
save you time, and it will help you learn Access more quickly. 
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Before You Start These ~essons 
Before you start these lessons, you already should have your basic Windows skills down 
pat-using a mouse; sizing, moving, opening, and closing windows; using dialog boxes, 
and so on. (If you haven't already done so, you should browse through Chapters 1 and 2 
to get an idea of what you'll be doing here.) 

For best results, give yourself 15 to 30 uninterrupted minutes to finish each lesson. If 
you need to pause after a lesson, see "Taking a Break" at the end of Lesson 1. To resume 
with the next lesson, see "Returning from a Break." 

~esson 1: Creating a Database and Tables Rutomaticall~ 
The first step to using Access is to start the program and go to the Microsoft Access star
tup dialog box or the main Microsoft Access window. If you don't know how, see 
Chapter 1 for help. 

Creating an Instant Database 
During these hands-on lessons, you'll create a new database (named Address Book Lessons) 
that can help you manage information about your contacts. You'll use the Database 
Wizard to create this database. Here goes: 

1. If you're starting from the Microsoft Access startup dialog box, choose Database 
Wizard and then click on OK. 

Or 

If you're starting from the main Microsoft Access window, choose File ~ New 
Database from the menu bar. 

2. Click on the Databases tab in the New dialog box and then double-click on the 
Address Book icon. 

In Windows 95, file name extensions for registered file types usually are hidden. If 
you've chosen not to hide those extensions, Access and other Windows 95 programs 
will show them in various dialog boxes. For example, the icon for the Address Book 
database will be named Address Book.mdb when file name extensions are displayed. For 
more about showing or hiding file name extensions, see Chapter 5. In this book, we'll 
assume file name extensions are hidden. 



W#3Q;liiM 
The first Data

base Wizard 
dialog box 

appears on top 
of the Address 
Book Lessons: 

Database 
window. 

LESSON 1: CREATING A DATABASE AND TABLES AUTOMATICALLY 

3. Type Address Book Lessons in the Pile Name text box of the File New Database 
dialog box and then click on Create or press Enter. 

Access normally looks for and stores your databases in a folder named 
\My Documents on the disk drive where Access is installed. To change this default 
location, open any database and choose Tools >- Options, click on the GenerGi 
tab, and specify a folder name in the Default Database Folder text box. To returt:J 
to the default setting, change the folder name in the Default Database Folder text 
box back to. (a period). See Chapter 15 for more details. · 

You'll see an empty database window titled Address Book Lessons: Database. After a 

brief delay, the first Database Wizard dialog box will appear atop the database window, 
as shown in Figure 3.1. This dialog box tells you something about the database you're 
about to create. 

• 

The Address Book database wiU store: 

• Add1ess infmmation 

Click Ne•t to continue 

Cancel Einish 

Understanding the Wizards 
The Database Wizard will ask you a few questions and then use your answers to build 
tables, forms, and reports automatically. Read the first Database Wizard dialog box and 

then click on Next. The second dialog box, shown in Figure 3.2, asks which fields to 
include in each table and whether to include sample data. 
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M#L3Q;llfW 
The second 

Database 
Wizard dialog 

box lets you 
choose optional 
fields for tables 

in the database 
and whether 

to include 
sample data. 

Dat<1base Wizard 

The database you've chosen requires certain lields Possible additionallieJds are shown ~alic 
below, and may be in more than one table. 

Do you want to add any optionallields? 

T eblo in the cla!&>:a 

Do you want sample dato iro the database? 

r.;:Fird Name 
P'La.t N~rne 
P' Spou$e Namo 
r GJilknN~I/1# 

Having sample data can help you to learn to use the database 

r~Yes. incioJde sample data 

finish 

• 

All the Access Wizards work in similar ways, and they have the same buttons at the 
bottom of each dialog box (see Figure 3.2).Just follow the directions, answer questions, 
and click on the buttons described below until you finish using the Wizard: 

Cancel Cancels the Wizard and returns to wherever you were before you started 

the Wizard. 
Back Returns you to the previous Wizard dialog box. 
Next Continues to the next dialog box. 
Finish Goes straight to the last Wizard dialog box. The Wizard will use default set

tings for any dialog boxes that it skips. The Finish button is available only when the 
Wizard has enough information to complete its job. 

Choosing Optional Fields for Your Tables 
A field is a single unit of information stored in a table; for example, a person's name, 
address, or phone number. When you use the Database Wizard to create a database, all 

the necessary tables and fields will be defined automatically and you don't have to 
make any changes. But if you do want to include optional fields, or omit fields, here an 

the steps to follow: 

1. Scroll to and click on the name of the table you want to work with in the tables lb 
at the left side of the dialog box shown in Figure 3.2. (The Address Book databas 

contains only one table, and it 's selected already.) 
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2. Scroll to the field you want to work with in the fields list at the right side of the 
dialog box. To include the field, check the box next to its name. To omit the field, 
clear the check mark from the box. As usual in Windows, clicking on a checked 
box clears the check mark; clicking on an empty checkbox puts a check mark in 
the box. 

3. Repeat steps 1 and 2 as needed. 

For these lessons, we'll assume you've chosen the fi elds that the Wizard suggested 
initially. That is, italicized fields are not checked, and non-italicized fields are checked. 

Including Sample Data 
The Database Wizard can add some sample data to your database. Using sample data 
will help you learn to use the database more quickly, and it will save you time. (You can 
delete the sample data later.) 

We want you to start with some sample data, so please select (check) the box next to 
Yes, Include Sample Data (refer to Figure 3.2); then click on the Next button to con
tinue to the third Database Wizard dialog box. 

If you forgot to check the Yes, Include Sample Data box before clicking on the Next 
button, it's easy to recover. just click on the Back button in the next dialog box that 
appears, check the Yes, Include Sample Data box, and then click on Next. 

Choosing a Style for Forms 
The third Database Wizard dialog box lets you choose a background color and general 
style for database forms (called screen displays in the Database Wizard dialog box). In 

Figure 3.3, we've selected the Standard style. To choose a style, click on it in the list of 
styles. The left side of the dialog box will show a sample form that reflects your current 

choice. Preview any styles you wish and then choose Standard, which is the style used 
throughout this chapter. When you're ready to continue, click on the Next button. 

Choosing a Style for Printed Reports 
In the fourth Database Wizard dialog box, you'll choose a general style for printed 
reports (see Figure 3.4). Again, you can click on a style in the list and preview a sample 

until you find a style you like. Pick a style that appeals to you (or use the Compact style 
that we chose) and then click on Next. 

0 
~ 
·~ 
Ql 

> 
0 
c: 
< 
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M#(ijQ;l#IM 
The third Data

base Wizard 
dialog box with 

the Standard 
style selected 

for forms. 

M#ldQ;IItM 

Database Wizard 

... 
M "" -• " 
II 

l!!!ie!F"f 

Dalabaxe Wizard 

-~ 

---
C6ncel 

The fourth 
Database 

Wizard dialog 
box with the 

Compact report 
style selected. 

\~·'hat slyle- wc•uld }'C•u llke fm pri11ted report:;? 

M1CKXHXH 

xHxx XKXK 
:1-:XMX:t:<>OC:« 

' 

Title 
Labelfl•om Detail 
Contr ol fr om Delail 

, __ . 
.._ 

C<3nc.t l 

I 

Clo1,1ds 
Col1)rflll1 
Colorful 2 
Cl u'k 
Evergreen 
Fla:< 
lnternatiot 1al 
PaUe!rl 

SiCifiO 

Bol 
Ca::.ual 

Corpor.:.te 
Formal 
SoH Gr.:':ly 

• 

finish 

• 

~-C>...-IE G In Chapter 1 3 you'll learn how to set up your own form and report styles and how 
to add them to the list of predefined styles . You'll also find out how to reformat an 
existing form or report with a different styl e. 

---------------------------------·~~!<li~~~:"".ot!l!!~ 
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Choosing a Database Title and Adding a Picture 

MndU;lUM 
The fifth Data

base Wizard 
dialog box lets 

you choose a 
title and a 

picture to use 
for your data

base. In this 
example, we've 

used the sug
gested title and 

chosen the 
Music picture 

from the 
\MSOffice\ 

Cl i part folder. 

In the fifth Wizard dialog box (see Figure 3.5), you can choose a different title for your 

database. This title will appear on the Main Switchboard form (which you'll see soon) 
and on all reports. For now, Address Book is fine, so leave the title unchanged. 

You also can include a picture on all reports. Just for grins, add a picture by following 

these steps: 

1. Click on Yes, Include A Picture to check that option and then click on the Picture 

button. 
2. Use the techniques discussed in Chapter 1 to locate the folder named \MSOffice\ 

Cl i part in the Insert Picture dialog box (see Figure 3.6). Assuming you did a stan

dard installation, you can just type \msoffi ce\cl i part in the File name text box 

and press Enter. 
3. Make sure the Preview button is selected (pushed in) on the dialog box toolbar and 

then click on a file name in the left side of the dialog box. Each time you click on 

a file name, a preview of the picture it contains will appear in the preview area. The 
example in Figure 3.6 shows the Music file name and preview selected. 

4. Click on OK when you're satisfied with the picture you've selected. The sample pic

ture will appear in the Database Wizard text box, next to the Picture button. 
5. Click on Next to continue to the next dialog box. 

Oalaba1u Wrzard j 

Wh•t would )IOU like the tOle of the database to be? 

Do J10U want a pictlle on ai repo~ts? 

(;; Yes. I'd like to include a picture 

• 

0 
~ 
·~ 

Cl.l 
> 
0 
c 
ct 
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M#lflQ;l#IW 
After clicking on 

the Picture 
button in the 

dialog box 
shown in 

Figure 3.5, you 
can search for 

and preview 
pictures. The list 

of graphics will 
depend on 

which software 
you've installed 

and which folder 
you've chosen 

to search. 

Insert Picture Iii) f3 

Look tn I U Cli!>l>rt 

[Jf'c:ljle< 
~ACCOU11 

!Auto 

Flower 

Hardware 

Legal 

Medical -~Software 
jta' Sporto 

Find files that match these crKeria: 

File !lame: I 
f~ ol JVpe, jr:G:-ra--:ph-:-l,c-.~. R:::l.,.-----:-o 

10 file[s) found 

T e]it or property: l :o:::J £:ind Now 

l..elt QlOdfred: ,.., 01"\)1-•• -ti-me ___ EJ-. New Search 

• 

Finishing Up 
That's all the information the Wizard needs. In the final dialog box, you have two options: 

Yes, Start The Database Leave this option checked if you want to go to a Switch

board form that lets you start working with your database immediately. Clear this 
option if you want to go directly to the database window, bypassing the Switch
board. For now, leave this option checked. 

Display Help On Using A Database Checking this option will display online 
help about using a database. Leaving this option unchecked won't display any 
extra help. Leave this option unchecked for now. 

To create the database with all the choices you made, click on the Finish button 
now. (If you need to revisit any of the previous Database Wizard dialog boxes, click on 
the Back button as needed.) 

Wait patiently for a few moments while the Database Wizard conjures up an entire 
database of tables, forms, reports, and other objects. (On-screen bars will keep you 
informed of the Wizard's progress as it works.) When the Wizard finishes its job, you'll 

see the Main Switchboard form for your database (see Figure 3.7). 
Congratulations! You've created your first Access database. Easy, isn't it? In the fol

lowing lessons, you'll learn how to work with and customize your new database. 
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At Your leisure 
To Jearn more about databases and tables, see Chapters 5 through 7 of this book. Or go to 
the Access Help Contents, open the Creating A Database A11d Working In The Database Win
dow book, and then peruse the subtopics. Or just skip all that and move on to Lesson 2. 

If you want to take a break at the end of this or any other Jesson, close your database 
as discussed next under "Taking a Break." Before you resume a lesson, reopen the Address 
Book Lessons database (see "Returning from a Break"). 

Taking a Break 
Anytime you want to take a break at the end of a lesson, do one of these steps to save 
your work and close the database (before you turn off the computer!): 

• If you're viewing the Main Switchboard form, shown in Figure 3.7, click on the 
button next to the last option, Exit this database. 

• If you're viewing the database window (see Chapter 1), choose File ~ Close from 
the menu bar or press Ctrl+W or click on the Close button on the database window. 
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Then, if you're done using Access for a while, exit Access by choosing File> Exit from 
the Access menu bar. If you plan to turn off your computer, exit any other programs that 
are running, choose Start > Shut Down from the Taskbar, and then choose Shut Down 
The Computer?> Yes in the Shut Down Windows dialog box. When the message tells 
you it's safe to turn off your computer, go ahead and turn it off (if necessary) . 

Returning from a Break 
To resume with a new lesson after taking a break, use any of the techniques you learned 
in Chapter 1 to open the Address Book Lessons database and its Main Switchboard 
form. Here's a summary of the steps: 

• If you're at the Microsoft Access startup dialog box and you see Address Book Les
sons in the list under Open An Existing Database, double-click on that name. 

• If you're at the Microsoft Access startup dialog box and Address Book Lessons doesn't 
appear in the list, make sure More Files is highlighted, click on OK, and then double
click on Address Book Lessons in the list of file names. 

• If you're at the Microsoft Access main menu, choose File from the Access menu bar. 
Then, if Address Book Lessons appears near the bottom of the File menu, click on its 
name. If it doesn't appear, choose Open Database and then double-click on Address 
Book Lessons in the list of file names. 

• If you're at the Windows 95 desktop and you've used the Address Book Lessons 
database recently, choose Start> Documents> Address Book Lessons. 

The Address Book Lessons database will open, and the Main Switchboard form will 
appear (see Figure 3. 7) . 

Some Important Switchboard and Database Window Tips 
These tips are worth remembering as you work with the Address Book Lessons database: 

• To open the Address Book Lessons database window without opening the 
Main Switchboard first, hold down the Shift key while you open the Address 
Book Lessons database. You'll be taken directly to the database window. 

• To open the Main Switchboard form from the database window, click on the 
Forms tab on the database window and then double-click on the Switchboard 
form name. 

• To open the database window without closing the Switchboard form first, 
press Fll or click on the Database Window toolbar button or choose Window > 
Address Book Lessons : Database from the menu bar. 
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• To open the database window when it's minimized on the Access desktop, 
click on the database window's Restore button or double-click on the window's 

title bar or press Fll. 

~esson 2: Exploring the Address Book ~essons Database 
Before you enter any data or print any reports, why not explore the Address Book Les
sons database and Switchboard forms a little? Because you asked the Wizard to add 
sample data, you'll have plenty of places to investigate. 

Exploring the Address Book Form 
Let's start with the first option on the Main Switchboard (refer to Figure 3.7): 

1. Click on the button next to Enter/View Addresses. You'll see the Addresses form, 
which lets you review or change information for each contact. Here's what you can 
do with the buttons at the bottom of this form: 

• To preview and print a fact sheet about the contact shown on the form, click 
on the Preview Fact Sheet button. You'll learn more about previewing and 
printing in Lesson 4. (For now, click on the Fact Sheet report's Close toolbar 
button or press Ctrl+W to return to the Addresses form.) 

• To dial your contact's phone with your computer's modem, click in the box 
that contains the phone number you want to dial and then click on the Dial 
button. An easy-to-use AutoDialer box appears. (For now, click on Cancel if 
you've opened that dialog box.) 

• To switch between page 1 and 2 of the Addresses form, click on the 1 or 2 
button-or click on the Page Up and Page Down key. 

2. Click on its Close button or press Ctrl+W to return to the Main Switchboard form 
when you are finished exploring the Addresses form. 

In Lesson 4, you'll learn how to add and change data and how to use navigation but
tons to move from record to record. For now, just take a look at what's available and 
don't worry too much about changing any data or viewing other records in the table. 
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Exploring the Address Book Reports 
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The Main Switchboard's Preview Reports option lets you preview and print a variety or 
reports about your contacts. Here are some steps to try: 

1. Click on the button next to Preview Reports. A new Reports Switchboard wi 
appear (see Figure 3.8). 

2. Click on a button to preview one of the reports (the Greeting Card List, for exarr 
pie). Lesson 5 will show you how to work with reports. 

3. Return to the Main Switchboard by clicking on the Close button on the Previe1 
window's toolbar or by pressing Ctrl+W. 

4. Return to the Main Switchboard form by clicking on the button next to Return t 
Main Switchboard. 

<;I,. flllaesoll Access .. g EJ 
Eie E_dil ~iew Insert Fgrmat fiecords loots Y{lndow .!:ielp 

IDJ Preview lheAddlesses b~ Last Name Report 

_j P1eview the Fact Sheet ReP<Xt 

_j Preview the 80\hdaJ•S This Month Report 

_j Preview the Greeting Card List Report 

~ Return to Main Sw~chboaJd 
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Other Buttons on the Address Book Main Switchboard 
Figure 3.7 shows two more options on the Address Book Main Switchboard: 

• Change Switchboard Items Lets you add, change, and delete prompts on the 
switchboards and create new switchboards. We'll look briefly at ways to custom
ize the switchboards in Lessons 7. Chapter 21 of this book explains how to create 

custom switchboards. 
• Exit this Database Lets you close the Main Switchboard form and the Address Book 

Lessons database window in one step and return directly to the main Microsoft 

Access menu. 

Lesson 3: Creating and Customizing a Form 
An Access form is like a fill-in-the-blanks paper form, except that you fill it in using the 
keyboard rather than pencil or pen. Our Address Book Lessons database already has a 
nice form. But let's go ahead and create a new one for practice: 

1. Close the Address Book Switchboard form and return to the database window. To 

do so quickly, click on the Close button in the upper-right corner of any Address 
Book switchboard form and then press Fll to restore the database window. 

2. Click on the Tables tab in the database window and then click on the Addresses 
table name to highlight it. 

The Switchboard Items table contains entries that control the switchboard forms 
for your database. Do not change items in this table, or your switchboards may 
stop working correctly. In Lesson 7 you'll learn how to use the Switchboard Man
ager to maintain this table in a safe manner. 

3. Click on the drop-down arrow next to the New Object toolbar button (shown at 

left and second-to-last on the toolbar) and then choose Form from the menu that 

appears (or choose Insert >- Form). In the New Form dialog box, double-click on 
AutoForm: Columnar. Wait a few moments while Access creates an automatic form. 

Access instantly creates the form for entering and editing Address Book data and names 
it Addresses (see Figure 3.9). The form contains one CO!ltrol for each field in your table. 

A control is a graphical object that displays data, performs an action, or makes the 
-=-.... form (or report) easier to read. You'll learn more about controls in Chapter 13. 
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II'] Addresses ' I!!I~IJ 

First Nam~ 1Nancy 

LSSII\!atOO O..~olio 

Spouse Nllffi< P&<JI 

507 • 21lh Ave. E 
Apt 2A 

etv Sealjle 

SlalePr~ 'IVA 

Po:tal COde 9812'2-

Country USA 

0 

Email Addres~ nancyd@anywhere com 

Record: ..!.!l.lJ f ti ., .. ,~ ( of 5 

Home Phone (504) 555·9657 

Work Phone (504) 555-9922 

Work Extehsk 

Fax Number (504) 555-7722 

Birthdete 8/4{72 

Send Card No 

Notes 

Modifying and Saving the Form Design 
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The new form is perfectly usable as-is. But chances are you'll want to tailor the Wizard 
instant form to your own personal tastes. We'll show you some basic skills for designir 
fancier forms. When you finish the next set of steps, your form will resemble Figure 3.1 

Whenever you want to change the look or behavior of something in Access, you 
must switch to Design view. In Design view, you'll see menu commands and toolba 
buttons that help you make changes. You also may see a grid, which makes it easier f, 

II'] Addresses II!J~ EJ 
, ; i .;:, 1:; l-4<~mo PllQne (504) 6$5-9857 

First Name WOikPhooo El)4 S$$r9922 

Las1 Name 'Davollo W~kE>:I. 

Spouse Paul F..x Number t-504) sss.n22 
Address 507- 2oth Ave. E. Birlhdete 8/4{72 

Apt 2A 
Send Card No 

C~y Seottle 
Notes 

state!Prov WA 

Postal Code 98122- Country USA 

Email Numbe1 nancyd@anywhere com 

Record: ~j 
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some people to size and align controls on the form. Let's switch to Design view now 
and move some controls around on the Address Book form. 

1. To switch from Form view to Design view, click on the Form View toolbar button 
(shown at left), or choose View ~ Design View from the menu bar. 

2. To give yourself lots of room to work, maximize the Design view window. 
3. To hide or show the optional tools in Design view (if they are covering your form 

or are missing), choose the appropriate options on the View menu. For example, if 
the Toolbox is in your way, choose View ~ Toolbox. For this exercise, select 
(check) the Ruler and Form Header/Footer options on the View menu. Leave the 
other options unchecked to hide those other tools. 

4. Scroll down until you can see the Country control and then click on the Country 
control (the empty box just to the right of the Country label). When selected, 
"move" and "size" handles appear on the control, as shown below: 

• • • 

5. Keep your finger off the mouse button and move the mouse pointer to any edge of 
the control until the mouse pointer changes to a "move" icon (a hand with all five 
fingers showing), as shown at left. 

6. Press the mouse button (without moving the mouse) and drag the Country control 
up and to the right until it's in line with the Postal Code control, as shown below: 

I~ 

These mouse operations may take some practice. If you don't get them right the 
....... =-... first time, repeat steps 5 and 6 until you do. 

You've now moved the Country control. You can use the same dragging technique 
to size controls and to move a label and/or text box independently. Try this technique 
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to move the EmailAddress control and label to fill in the gap left by the Country field. 
Always move the mouse pointer to an edge or corner of the control first until you see 
the mouse pointer change to the icon that best expresses what you want to do. The 
functions of the icons are summarized below: 

Move all selected controls. 

Move current control only. 

Size diagonally. 

Size horizontally. 

Size vertically. 

A Few Designer Tips 
Here are some designer tips that might help you fine-tune the form. (You don't need to 
try them now.) 

• To select several controls at once, hold down the Shift key as you select or drag 
a "lasso" around them. (To lasso those critters, start with no control selected and 
the mouse pointer on the grid or an empty part of the form, not on the control , 
Then drag a frame around all the controls you want to select.) 

• To select all the controls at once, choose Edit ~ Select All or press Ctrl+A. 
• To deselect one selected control or all selected controls, click anywhere outsidf 

the selection area . 
• To deselect only one of several selected controls, hold down the Shift key whilt 

clicking on the control(s) you want to deselect. 
• To size and align the selected controls, use the Format ~ Align and Format > 

Size commands from the menu bar (see Chapter 13). 
• To make a label fit its text exactly, select the label, move your mouse pointer tc 

any of the sizing handles, and then double-click on the sizing handle. Or select th< 
labels you want to resize and then choose Format ~ Size·~ To Fit from the menus. 

• To delete the selected control(s), press the Delete key. 
• To undo a change you're not happy with, choose Edit ~ Undo or press Ctr1+2 

or click on the Undo toolbar button. 
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To change the text in a label (the part that appears to the left of a control): 

1. Click on the label text so that selection handles appear around the label. 
2. Click inside the selection. An insertion point will appear and the sizing handles 

will disappear temporarily. 
3. Use normal Windows text editing techniques, including these, to change the text: 

• To highlight (select) text, drag the mouse through that text or double-click on 

a word. 
• To position the blinking insertion point, click the mouse or press the ~ and 

~keys. 

• To delete selected text or text at the insertion point, press Delete or Backspace. 
• To add new text at the insertion point, simply type it. 

4. Press Enter when you're done making changes. The selection handles will reappear 
around the label. 

Try Some Hands-on Designing 
Go ahead and try some more hands-on designing now. Don't worry if you don't get 
exactly the results we show-it's OK to make mistakes, and it's OK to experiment. 

1. Change the label text for these controls, as follows: 

• Change the label for the SpouseName control from Spouse Name to Spouse. 
• Change the label for the StateOrProvince control from State/Province to 

State/Prov. 
• Change the label for the WorkExtension control from Work Extension to 

Work Ext. 
• Change the label for the EmailAddress control from Email Address to 

Email Number 

2. Resize all the labels on the form so they have a snug fit. The quickest way is to select 
all the controls (Ctrl+A) and then choose Format ,.. Size )o- To Fit. 

3. Click in an empty area of the form to deselect all the controls. 

Next, make the Country control smaller so that it doesn't crowd the Notes control: 
Click on the Country control (the box to the left of the Country label). Move the mouse 
pointer to the sizing handle at the right edge of that control (the mouse pointer 
changes to a horizontal two-headed arrow) and then drag to the left until you've sized 
the control to your liking. 

To move the Country control closer to its label, make sure the Country control is 
selected and then move the mouse pointer to the sizing handle at the upper-left corner 
of the Country control (the pointer changes to a hand with one pointing finger) . Drag 
to the left until the Country control is closer to the Country label. 

.... 
0 

~ 
~ 

·~ 
~ 
> 
0 
c: 
< 



68 CHAPTER 3 • ACCESS IN AN EVENING 

Preventing the Cursor from landing in a Field 
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When you enter a new record, Access will assign a value to the AddressiD field auto
matically. (You can't change this value.) The form will be more convenient to use if you 
prevent the cursor (also called the insertion point or highlight, depending on its shape) 
from landing in that field . To disable the AddressiD control: 

1. Click on the AddressiD control (the box to the right of the AddressiD label) to 
select it. 

2. Click on the Properties toolbar button (shown at left) or choose View )1- Properties. 
You'll see the property sheet on the screen. 

3. Click on the Data tab at the top of the property sheet and then double-click on the 
Enabled option to change its setting from Yes to No (see Figure 3.11). The AddressiD 
control will be dimmed on the screen. 

4. Click on the Close button on the property sheet (or click on the Properties button 
or choose View )1- Properties) to hide the property sheet again. 

As you'lllearn later in this book, properties are characteristics of elements in your data
base, and you can change them anytime. Don't worry too much about properties now. 

~·Text Box. AddressiD D 
Format DMa ] Evri I othe( 1 AI 1 
Control Source . AddlesslD. 
Input Mask .... , -
Default Value .• 
YaMlatlon Rtk • . 
Y~Text. 

Enabled . " " " • tl !:.J 
Locked .. .. .. . • , No 
F1ter l~ . . . , . Database DefbUII 

• 

Closing and Saving the Form 
None of the design work you've done so far is saved yet, so saving is the next order of 
business. To save the form and close it: 

1. Choose File )1- Close or press Ctrl+W. 
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2. Click on Yes when asked about saving the form . 
3. Type Addresses! (or just accept the suggested form name) in the Save As dialog 

box and click on OK. 
4. (Optional) Click on the Restore button on the database window to restore the win

dow to its previous size. 

That's all there is to it! The form name will appear in the database window whenever 

you're viewing form names (that is, after you've clicked on the Forms object tab on the 
database window). In the next lesson, you'll open the form and start using it. 

At Your Leisure 

To reinforce what you've learned, and explore forms in more depth, look at Chapters 11 
and 13. Or go to the Access Help Contents, open the Working With Forms book, open the 

Basics book, and then explore any subtopics that intrigue you. Or just move on to Lesson 4. 

Lesson 4: Adding, Editing. Sorting. and Searching 
Your database now contains several objects, including a table and two forms. You can 
use either form to enter some data into the table. 

Opening the Form 
To open the Addresses! form: 

I. Start from the database window and click on the Forms tab. 

2. Double-click on the Addresses] form name, or highlight (click on) the name and 
then click on Open. Your form will appear in Form view (refer to Figure 3.10). 

Notice that the AddressiD field is dimmed and the cursor is positioned in the First
Name field. The cursor skips the AddressiD field because you changed the Enabled 
property for that field to No in the previous lesson. 

If you prefer to use the Addresses form that the Database Wizard created for you 
automatically, either double-click on the Addresses form name on the Forms tab of 
the database window or click on the button next to the Enter/View Addresses 
option on the Main Switchboard form. 
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litdQ;lllfM 
A new record 
added to the 

Addresses table 
via the 

Addresses] 
form you 

created earlier. 

Entering Data 
If you have a Rolodex or little black book of contact names, addresses, and other vital sta
tistics, grab it now. Or if you don't want to bother with real names and addresses, use the 
fake one shown in Figure 3.12. Either way, follow these general steps to add some names 
and addresses to your Addresses table via the Addresses 1 (or Addresses) form. (If the table 
is currently empty, you can skip to step 2 and begin entering data immediately.) 

1. Click on the New Record button (shown at left) on the toolbar or the navigation 
bar (see Figure 3.12) to move to a new, blank record. 

2. Type the person's first name into the First Name field; then press Tab or Enter or 
click anywhere within the Last Name field. 

3. Type that person's surname into the Last Name field; then press Tab or Enter or 
click within the Spouse Name field. 

4. Fill in each of the remaining fields, as shown in Figure 3.12. Here are some tips to 
help you enter the remaining data: 

• To move forward from one field to the next, press Tab or use the mouse. If 
the field doesn't display a vertical scroll bar and scroll arrows when the cursor 
lands in it, you also can press Enter to move to the next field. (The Address and 
Notes fields include vertical scroll bars and arrows.) If the field does display a 
vertical scroll bar and scroll arrows when the cursor lands in it, pressing Enter 
will end the current line of text and move the insertion point to the start of the 
next line within the field. 

!ffi Addresses 11!11~ £i ---- -~---~- -~- -~~-~ - -- -- -- ~ - -
) 

!~ .id e ::~lU 8 

First Name :Han~ey 

Last Name 1Sir.,pprnan 

Spouse Sheila 

Address 6691 West 47th street 

C~y Fridley 

Slatell'rov OH 

Postal Code 44147-

Email Number 7 4 7,594 7 

Record:~~ 

Home Phone (216) 555-1225 

Work Phone (216) sss, 1235 

-<~ Work Ext . 1£;1: .. -· 
Fox Number \ 216) 555-1236 

Bitthdate 4f714 7 

Send Card Yes 

Notes Hanley is a swell guy who makes !!J 
awesome gazpacho and pasta :...J 
sandwiches I ~ 

Country USA 

• 
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• To leave a field empty, press Tab to skip it, or click on the field you want to 
type in next. 

• To enter Postal Codes, type the numbers only. The form automatically dis
plays a hyphen after the first five digits. Example: When you type 441471234 
in the Postal Code field, Access changes your entry to 44147-1234. 

• To enter telephone numbers, type the numbers only. The form automatically 
displays parentheses around the area code and a hyphen after the exchange. 
Example: When you type 2165551225 in the Home Phone field, Access changes 
your entry to (216)555-1225 as you type. 

• To enter birth dates, omit slashes between the numbers for the month and day 
if the numbers have two digits. If the numbers for the month and day have only 
one digit, type a slash to move to the next part of the date. Access will insert 
slashes in the field automatically. Example: When you type 121595 in the Birth
date field, Access automatically changes your entry to 12/15/95 as you type. To 
enter the numbers for an April 7, 1947 birthdate, type 4/7/47 or 040747. 

You can enter the punctuation in the postal code, telephone number, and date 
.. -.. fields, but doing so takes extra work. Data entry shortcuts, such as automatically 

inserting parentheses and hyphens in telephone numbers, are controlled by Input 
Mask properties in the table or form design. See Chapters 6 and 1 3 for more details. 

5. Press Tab to move to the next blank record after filling in the last field (Notes). 
6. Repeat steps 2 through 5 to fill in more names and addresses. For practice, make at least 

three entries. If possible, include some entries that have the same State/Province. 

Making Changes and Corrections 
If you're an experienced Windows user, you'll probably find that editing text in an 
Access form (or the Datasheet view) is similar to typing and editing text in any other 
Windows program. But even if you're not experienced, these techniques can help you 
fix typing mistakes: 

• To delete text at the highlight or insertion point position, use the Backspace 
and Delete keys. 

• To move to the next field, press Tab. To move to the previous field, press Shift+ Tab. 
To move to any field in the form, click on that field. 



72 CHAPTER 3 • ACCESS IN AN EVENING 

• To switch between Navigation mode and Edit mode, press F2. You're in Naviga
tion mode when you use the keyboard (Tab, Shift+ Tab, and Enter) to move to 
another field; in this mode, the field 's contents will be selected, and anything you 
typ wi ll repi11CI' what' · already in the fie ld. When you witch t Edit m de, you an 
cha11ge (rather than r~tlace) what' · already in the field; in this mode, the blinking 
1J1sertion p iJll replace the selection highlight You can pr s F2 anytime you need 
to switch from one mode to the other. 

• To move to other records, use the navigation bar at the bottom of the window 
(see Figure 3.13). Or press Page Up and Page Down to scroll up and down through 
existing records. 

~ -~....-E 

•naw'*''' 
The navigation 
bar allows you 

to move through 
existing records 

and to add 
new records. 

In the Addresses form created by the Database Wizard, Page Up and Page Down 
display the first or second page of the Address form, respectively. Pressing Page 
Down when you're on the second page of the form takes you to the second page 
of the next record . Pressing Page Up when you're on the first page of the form 
takes you to the first page of the previous record (if any). 

• To switch to Datasheet view, where you can see all the data that you've entered 
s far, click on th drop-down arrow next to lh Form View toolbar button 
(shown al left, <tn I the fu:st button on t.he too lbar) and then choos Data5heet 
View; or choos View> Datasheet View (see Figure . 14). You an mak changes 

and con tions in Datashect view, If you wi ·b- it' n t necessary to switch back 
to Form view. 

• To resize columns in Datasheet view, move the mouse pointer to the vertical 
line at the right edge of the column header for the column you want to resize and 
then drag the line to the left or right. For a snug fit, double-click on the vertical 
line that's just to the right of the column name. 

• To move an entire column in Datasheet view, move the mouse pointer to thE 
column name in the header, click the mouse, and then drag the column to the left 
or right. 

I Record: ...!.ll.!J I 
-~~= 
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• 

Anna 908 \,~/ C3pital I·'V'ay T:::~ c oma VV'.A. 
IRober1 722 Moss Bay E:lvd_ l<irkland VVA 

t-.j iehael 4110 Old Redr11ond Rd Redrnond VVP.. 
Buchanan 

lsheil$ 
14 Garrett Hill London 

ISirappman 8891 'Nest 47th Street Frid1e)' OH 
r 

• To switch to Form view, click on the drop-down arrow next to the Form View 

toolhar button and choose Form View; or choose View> Form View. 

If you click on the Form View tool bar button (instead of clicking on the drop-down 
arrow next to that button), you'll switch to the view that's shown on the button. 
For example, clicking on the Form View button when you're in form view takes you 
to form Design view. Clicking on the Form View button when you're in form Design 
view takes you to Form view. 

~~Q·~a.-----------------------------------------------------------

You can't change the contents of the AddressiD field, and there's no reason to. In 
fact, you can't even move the cursor into that field. 

• To move to a new, blank record, click on the New Record button on either the 

tool bar or the navigation har (see Figures 3. 12, :·U 3, and 3. 14). 

• To delete a record , click on the record selector at the left side of the record and 

press Delete. Or click anywhere in the record you want to delete and then click on 

the Delete Hecord toolbar button (shown at left). When prompted, click on Yes i! 

you're sure you want to del ete the record or click on No to retain the record. 

Warning: Once you click on Yes to delete the record, it's gone for good! 
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Don't Save Each Record 
In case you're paranoid about losing your work (which certainly is understandable!), 
rest assured that as soon as you finish filling in (or changing) a record and move to 
another record, Access saves that record to disk. The only record that isn't saved is the 
one you're editing at the moment. (This unsaved record is marked at the left with a 
pencil icon.) 

Sorting and Filtering 
After you've put a few records into your table, you can unleash Access's real power. Let's 
begin by sorting (alphabetizing) the records: 

1. Switch to Datasheet view if necessary. To do so, choose View )o. Datasheet View 
from the menu bar. 

2. Click on any person's surname to move the cursor into the Last Name column. 
3. Click on the Sort Ascending toolbar button (shown at left), or choose Records )o. 

Sort )o. Sort Ascending. Or right-click and then choose Sort Ascending from the 
shortcut menu. 

Instantly your records are sorted (alphabetized) by surnames. You can follow steps 1 
through 3 to sort on any field in your table. Try it and see. 

Now suppose you want to see only contacts who live in Washington (or whichever state 
you want to look for). Here's a quick way to filter out those unwanted non-Washington 
contacts temporarily: 

1. Put the cursor in any State/Province field that contains WA (for example)-be sur' 
not to highlight any text in the field. 

2. Click on the Filter By Selection toolbar button (shown at left) or choose Records > 
Filter )o. Filter By Selection. Or right-click on the field and choose Filter By SelectiOJ 
from the shortcut menu. (If you prefer to see all records except those for your Wash 
ington contacts, right-click and choose Filter Excluding Selection instead.) 

The non-Washington records will disappear temporarily. To return the records to 
their original order and display the hidden records again, choose Records )o. Remove 
Filter/Sort; or right-click and choose Remove Filter/Sort from the shortcut menu. 

Filter by Input is another easy way to filter records. This feature is new to Access 97. To se 
how Filter by Input works, point with your mouse anywhere in the State/Prov field (but no 
on the header!) and right-click. In the box after Filter For, enter WA and press Enter . As 
with Filter by Selection, to display the hidden records again, choose Records )o. Remove 
Filter/Sort; or right-click and choose Remove Filter/Sort from the shortcut menu. 
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You can sort and filter records in Form view or Datasheet view. However, we sug
gest using Datasheet view because the results are easier to see from there. See 
Chapter 9 for more about sorting and filtering. 

Finding a Record 
Suppose you've added hundreds, or even thousands, of names and addresses to your 
Addresses table, and now you want to look up a particular contact's address or phone 
number. Here's the easy way to do a lookup: 

1. Switch to Form view or Datasheet view (choose View > Form View or View > 
Datasheet View). 

2. Click in the field you want to search (in this example, click in any Last Name field). 
3. Choose Edit> Find or press Ctrl+F or click on the Find toolbar button (shown at 

left). You'll see the Find In Field dialog box. 
4. Type exactly the last name you're looking for in the Find What text box. (Don't 

worry about upper/lowercase, but do spell the name correctly.) 
5. Click on the Find First button. The Last Name field of the first record that has the 

requested name will appear highlighted on the screen. (If Access didn't find a 
match, a message will appear; click on OK to clear the message.) 

...-.-
If several people in your table have the same last name and you want to find each 
one in turn, click on the Find Next button as needed. When Access tells you it has 
finished searching, click on OK. 

6. Click on the Close button in the Find In Field dialog box when you're done searching. 

Remember: Computers Are Dumb! 
If your search doesn't find what you were expecting, remember that the computer isn't 
smart and it can't read your mind. You must click on the field you want to search before 
starting the Find command and typing the text you want to search for. (For example, 
if you click on the Address field and search for Strappman, you'll get no match.) 

Likewise, if you type a first name such as Steven into your table and then search for 
Stephen, Access won't find the correct record. Steven and Stephen are similar enough for you 
to say "Yeah, that's a match. " However, Access isn't smart enough to figure out that Steven 
and Stephen sound alike, and it certainly won't know if you want to match either name. 

0 
~ 
·~ 
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> 
0 
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Filter by Form, Advance Filter/Sort, and queries let you search for text that's similar 
:.:..;:;;=....o. to text that you enter. For example, you can tell Access to find a First Name like 

St*en. This statement will match records that contain Steven or Stephen in the First 
Name field. See Chapters 9 and 10 for details. 

Closing the Form or Datasheet 
When you're done playing with the data, close the Form or Datasheet view: 

1. Choose File>-- Close or press Ctrl+W. Access might ask you if you want to save your 
current work. 

2. Click on Yes if you want to save any filtering or other changes to the table or form; 
click on No if you want to discard those changes. 

Don't worry if you're not asked for permission to save your work-Access will ask 
only if you've altered the Form or Datasheet view. All the names and addresses you 
typed are stored safely on disk for future reference. 

At Your leisure 
If you'd like to explore the topics described in this lesson on your own, skip to Chapter 9. 
To explore the topics online, go to the Help Contents, open the Finding And Sorting Data 

book, and then investigate the subtopics shown. Or move ahead to the next lesson now. 

Lesson 5: Creating and Printing Reports 
In this lesson you'll create, preview, and print a set of mailing labels. These mailing labels 
will be a nice addition to the Birthdays This Month, Fact Sheet, Addresses by Last Name, 
and Greeting Card List reports that the Database Wizard created for you automatically. 

Preparing Mailing labels 
Let's prepare a report that can print names and addresses on standard Avery mailing 
labels. Here are the steps: 

1. Click on the Tables tab in the database window and then click on the Addresses 
table name. 

2. Click on the drop-down arrow next to the New Object toolbar button (shown at 
left and the second-to-last toolbar button) and then choose Report (or choose 
Insert >-- Report from the menus) . 
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3. Double-click on Label Wizard in the New Report dialog box. In a moment the Label 
Wizard dialog box will ask, What label size would you like? 

If you forget to choose a table (or query) in step 1, you'll need to choose one 
.--.... from the drop-down list in the New Report dialog box. 

IUdU;liiJW 
Fields from the 

Addresses table 
arranged for 
printing on a 
mailing label. 

4. Choose Sheet feed under Label Type if you are using a laser printer (or other sheet
fed printer) to print labels. Otherwise, choose Continuous (if you are using a dot
matrix printer to print labels). 

5. Scroll to and click on the appropriate Avery label size and then click on Next. 

The Avery label number and label dimensions are printed on the box of labels. If 
you don't have labels already, just pick Avery number 5095 or some other two
across size. 

6. Choose any font and color options you want to use. The Sample text at the left side of 
the dialog box will reflect your current choices. Click on the Next button to continue. 

7. Use these techniques to fill in the Prototype Label box, making it look like the 
example shown in Figure 3.15. 

label Wrzard 

Avoiloble lields: 

Sp!Me>NIIII\e 
Adclre<t 
City 
StateDoProvlnce 
Pot\lliCode 

EOMjlll.cjdl~.~ 

Whot would J10U like on your mailing label? 

Con t1~t your label on the rig1t by choosing fields from the lelt. '1'01.1 maY also 
type t that you would like to see on every Iobei right onto the i)IOIIII)ope. 

Prototype label: 

{FirstName} {LastName} 
fAddress} 
{City). IStateOrProvince} {PostaiCode~ 

Concel !io.t ) ~ _.::.Ei_nis_h __. 

• 
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• To add a field to the label, click in the Prototype Label box where you want the 
field to appear. Then double-click on the field in the Available Fields list, or click 
on the field and then click on the > button. The field will appear in the Proto
type Label bo . 

• To add a space, punctuation mark, or other text, click where y u want the 
spac o.r text to appear (if the insertion point isn't there already) nd then press 
the appropriate key(s) on your keyboard. 

• To start a new line on the prototype label, click on the next line in the Proto
type Label box or press J, or Enter. 

• To delete a field or text, position the insertion point in the Prototype Label 
box where you want to start deleting and then press the Delete or Backspace 
key as needed. Or select text with your mouse or keyboard and then press 
Delete or Backspace. 

8. Click on Next when you're done filling in the Prototype Label box. Access will ask 
you which fields you want to sort by. 

9. Scroll down to PostalCode in the Available fields list and double-dick on that field 
name. (If you prefer to sort by LastName and FirstName, double-click on those field 
names instead.) Click on Next to continue. 

If you accidentally double-click on the wrong field(s), click on the << button to 
clear all the fields and then double-click on the correct field(s). To clear just one 
field, click on that field in the Sort by list and then click on the < button. 

10. Click on the Finish button in the last dialog box and wait a few seconds. 

The Wizard will create a report with names and addresses formatted for the label size 
you specified. When the Wizard is done, you'll see a preview of the labels on the screen 

Closing and Saving the Report 
You'll learn more about how to preview and print the report in a moment. But first, save 
the report and close the report preview window. To do so, choose File>- Close or press 
Ctrl+W. (If you click on the Close toolbar button by accident, you'll be taken to Design 
view. Just press Ctrl+W to return to the database window quickly.) Your report format is 
saved with the name Labels Addresses as you can see by clicking on the Reports tab in tht 
database window. 
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Don't Reinvent the Wheel! 
Keep in mind that Access has saved the report format, not its contents. So even if you 
add, change, or delete addresses in the future, you do not need to re-create the reports 
to print the data. Whenever you print a report, Access automatically puts the table's 
current data into the report's format. 

Previewing and Printing a Report 
Previewing and printing a formatted report is a snap. Here are the steps: 

1. Make sure your printer is ready. If you want to print on mailing labels, load the 
labels into the printer. 

2. To see the list of available reports, do one of the following: 

• If you're starting from the database window, click on the database window's 
Reports tab. You should see the names of the reports the Database Wizard cre
ated, plus the one you created. 

• If you're using the Main Switchboard form in your Address Book applica
tion, click on the button next to the Preview Reports option. You'll see options 
for printing reports created by the Database Wizard. (Later in this chapter, we'll 
show you how to add your new Labels Addresses report to this list of options.) 

3. To preview the report, do one of the following: 

• If you're starting from the database window, click on the name of the report 
you want to print (for example, Labels Addresses) and then click on the Preview 
button on the database window; or just double-click on the report name. You 
also can choose File >- Print Preview from the menu bar. 

• If you're starting from the list of reports on the Reports Switchboard, click 
on the button next to the report you want to view. 

To print a report from the database window without previewing it first, click on the 
report name you want to print and then choose File >- Print >- OK. 

4. The report will open in Print Preview mode with sample data shown. (Maximize 
the window if you wish.) Here are some tricks you can use to view your report: 

• To zoom in and out between 100 percent magnification and a full-page view 
that fits on your screen, move the mouse pointer into the report area and click 
the mouse, or click on the Zoom toolbar button (see Figure 3.16) . Click the 
mouse on the Zoom button again to return to the previous size. 
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•naw••ew 
The Preview 

mode too/bar. 

...... 

• 
)( 

• To zoom to various magnifications, ch ose options fro m the to !bar's Z om 
Control drop-down list. Or righ t- lick in the rep rt area, ch ose Zoom fro m 
the shortcut menu, and then choose a rnagnifl ation. Or cho se View>-- Z rn 
options from the menu bar. 

• To display multiple pages at once, right-click in the report area, choose Pages, 
and then choose a page layout. Or choose View >-- Pages options from the menu 
bar. Or click on the toolbar's One Page and Two Pages buttons. 

5. Choose File > Print (or press Ctrl+P) when you're ready to print the report and 
then click on OK in the Print dialog box that appears. Or to bypass the Print dialo~ 
box, click on the Print toolbar button (shown at left) . 

The Print dialog box lets you choose a printer, print the report to a file, select a 
::.o--""' range of pages to print, and specify the number of copies and collation method. 

The Setup button in that dialog box lets you change the margins and layout for 
the report. 

6. Click on the Close toolbar button to return to the database window or the RepOI 
Switchboard form. 

At Your Leisure 
Lf y u wnnt to learn mor about rep rts befor moving on to the next lesson, skip ahe; 
to hapters 12 and 13. r g t ll e Access He'lp ntents, open the Workl t1g WiU1 Repo 

b k, and then ex plore the subt pi s shown. 

Lesson S: Using Oueries 
You can use queries to isolate certain fields and records of data in a table, to sort da 
into alphabetical or numeric order, to combine data from several related tables, anc 
perform calculations on data in tables. In this lesson you'll use queries to set up a sim 
list that shows specific fields and specific records in the Addresses table in sorted orde 
last name. Then you'll change the query to show records for everyone in the table. 
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Creating a Query 

To create a query from your Addresses table: 

1. Click on the Tables tab in the database window and then click on the Addresses 

table name. 
2. Click on the drop-down arrow next to the New Object toolbar button (shown at left 

and the second-to-last toolbar button) and then choose Query (or choose Insert > 
Query from the menus). 

3. Double-click on Design View in the New Query dialog box. Figure 3.17 shows the 

query design window that appears. 

_ ., ..... -=: 

Using the Simple Query Wizard (and other query Wizards) is often the easiest way 
:..-""" to speed up the job of creating queries. However, for the query you'll be design-

The query 
design window 
shows the field 

list for the 
Addresses table 
in the top pane 
and the design 
grid in the bot-

tom pane. 

ing next, the from-scratch method is a little faster and it gives you practice using 
the query design window . 

T~~:~ I ~-
SOJI 1-J-===:::;~====~~=====:::====~====:;::;::====t====;:;:::====~ % o o o o Ctile~~ 1-----'='--....J...._----"='-----'----'='---..__--'='----'--

~-'~I~~~--~~~~~~~~~~~~~~~~~~ 

Choosing Fields to View 

To fill in the design grid, you first choose the fields you want to work with in the order 
you want them to appear. Follow these steps now to add the LastNamc, FirstName, 

City, StateOrProvince, and HomePhone fields to the grid: 

1. Maximize the query design window so you can see more columns in the design 

grid at once. 



82 CHAPTER 3 • ACCESS IN AN EVENING 

2. Add the LastName field to the design grid by double-clicking on that field in the 
Addresses field list near the top of the window. The LastName field will appear 
in the first blank column of the design grid. The Table row in that column will 
show the name of the table the field comes from, and the Show row will include 
a check mark to tell Access to display that field when you run the query. 

Here are two other ways to add a field to the query design grid: (1) Drag the field 
name from the Addresses field list to the appropriate column in the design grid; or 
(2) click on the Field box in the appropriate column of the design grid, click on the 
drop-down arrow that appears, and then choose the field name you want to use. 

3. Add the FirstName field to the design grid by double-clicking on that field in the 
Addresses field list. The field will appear in the next (second) column of the design 
grid. 

4. Add the City field by scrolling down in the Addresses field list and double-click on 
the City field name. 

5. Use the same techniques described in step 3 to add the StateOrProvince and Home
Phone fields to the design grid. 

If you add the wrong field to a column of the design grid, click in the Field box for 
that column, click on the drop-down arrow, and then choose the correct field 
name from the list. To delete a column in the design grid, move the mouse pointer 
just above the field name in that column (until the pointer changes to a black .J,), 
click the mouse to highlight the entire column, and then press Delete. 

Figure 3.18 shows the five fields in the query design grid. 

Choosing Records to View 
Suppose you want to view the list only for people who live in Washington. To do so, 
type wa (or WA) into the Criteria row under the StateOrProvince column. Here's how: 

1. Click in the Criteria box that's underneath the StateOrProvince column. 
2. Type wa or any state that you've stored in the table (see Figure 3.19). Don't worry 

about typing exact upper ase and lowercase letters. 
3. Press Enter. Access automatically adds quotation marks around the text you typed 

and moves the cursor to the next column. 
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Choosing the Sort Order 

l#dQ;llfl•l 
This query will 
sort the query 
results by last 

name and first 
name within 
identical last 

names. Because 
the Criteria for 

5 tateOrProvince 
is set to "wa " 

(Washington), 
the query 

results will 
show data for 

people in Wash
ington only. 

To sort the list by last name and then by first name within identical last names, tell Acces 
which fields (columns) to sort by and whether you want to sort in Ascending (A to Z) orde 
or Descending (Z to A) order. Here are the steps: 

1. Use the horizontal scrollbar to scroll the design grid back to the LastName colum 

and then click in the Sort box below the LastName column. Then click on U 
drop-down arrow that appears and choose Ascending from the list. 

2. Click in the Sort box below the FirstName column, click on the drop-down arrm 

and then choose Ascending. Figure 3.20 shows the query design window after yc 
complete this step. 

If you choose the wrong column to sort by, click on the Sort box below the appr 
priate column, click on the drop-down arrow, and then choose Not Sorted . 

or: 

Ready 
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Because the LastName column appears to the left of the FirstName column in the 
design grid, records will be alphabetized by people's last names. The FirstName field 
will act as a tie breaker, meaning that records with identical last names will be alpha

betized by first name. 

Running the Query 

IJM@ifJI 
The query 

results appear 
in Datasheet 

view. 

Running the query is a snap. To try it, click on the Run toolbar button (shown at left) 
or choose Query >- Run from the menus. 

The query results will appear in Datasheet view and will show only the Last Name, 
First Name, City, State/Province, Home Phone columns, and only the people in Wash
ington, alphabetized by last name and first name (see Figure 3.21). All the data is live, 

and you can change it the same way you change any data in Datasheet view. 

Record: 1i1...LJ I • ltll,.j of4 

You might have noticed that the column headings (or captions) shown in Fig
ures 3.14 and 3.21 don't exactly match the field names. For example, the field 
name for a person's surname is LastName; however, the column heading shows 
Last Name (with a blank space between words). These column headings are con
trolled by the Caption property in the table or query design. Chapter 6 explains 
how to change table properties, and Chapter 1 0 delves into changing properties 
in a query. 

• 

Changing the Query 
Changing the query to display an alphabetized list of all the records in the table is easy. 
Try it now: 

1. Click on the Query View toolbar button (shown at left, and the first button on the 
toolbar) or choose View>- Design View to switch back to the query design window. 
Maximize the query design window if necessary. 
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l#frlQ;IIIjM 
The datasheet 
after removing 
"wa" from the 

StateOrProvince 
field of the query 
design, running 

the query again, 
and restoring 

and resizing the 
window. 

2. Delete "wa11 in the Criteria box below the StateOrProvince column. To do this quickl) 
select (drag your mouse through) "wa" and then press Delete. 

3. Run the query again (click on the Run toolbar button). 

Now the Datasheet view resembles Figure 3.22. Because you removed "wa" (Washing 
ton), the query results show all records in the table-not just the people from Washingtor 

Just for grins, print a quick copy of this list now by choosing File >- Print >- OK orb 
clicking on the Print toolbar button. 

Re~or<t. ..!i1...t.J I 

Lond~n 
Fridley OH 

(504) 555-~57 
(504) 55_5:94~ 
(504} $5-3412 

; (504) 5~5-B122 
( 7'1) 555-4843 
(?16) 555-1225 

I 

Saving and Reusing the Query 
You'll probably want to see an updated list sometime later, perhaps after you've add 
deleted, or changed some records. Rather than re-creating this query each time, you 1 

save it and reuse it anytime. To save the query now: 

1. Click on the Save toolbar button or choose File >- Save. 
2. Type a valid Access object name (such as Addresses PhoneList Query) and 1 

click on OK. 
3. Close the Select Query window (press Ctrl+W). The query design and datashee1 

disappear, but your query will be saved. 

You can save the query design from the design window or the datasheet windc 
the steps are the same. You also can save the design when you close the wine 
If you're asked about saving changes, click on the Yes button and enter a qw 
name if prompted to do so. 
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To run a saved query, go to the database window (press Fll if necessary), click on the 
Queries tab, click on the query you want to run (Addresses PhoneList Query in this 
example), and then click on the Open button on the database window. Or just double
click on the query name. The query will run on the latest data in your table. (If you 
wish, close the datasheet window and return to the database window.) 

.... _,...-E 
To change the query design instead of running the query, click on the Queries tab 
on the database window, click on the query you want to change, and then click on 
the Design button on the database window. 

At Your leisure 
To learn more about queries, see Chapter 10. Or open the Access Help Contents, open 
the Working With Queries book, open the Creating A Query book, and then explore the 
subtopics that appear. 

~esson 7: Customizing an Application 
Now you've created several database objects-a table, a form, a report, and a query. 
But those objects aren't put together in a way that allows people who know nothing 
about those objects to use the database easily. To make your database extra easy to use, 
you can add these objects to the "turnkey" application that the Database Wizard created 
for you automatically. In this lesson, you'll learn some techniques for doing just that. 

Adding a Hyperlink to a Form 
Hyperlinks are a new feature of Access 97 that let you jump to other Access database 
objects or even to information on the Web. We'll step through a simple example here 
that shows you how to add a hyperlink to jump to the labels report from the Addressesl 
form we created in Lesson 3. For more information on working with hyperlinks, check 
Chapters 7 and 8. 

1. Click on the Forms tab, click on Addressesl, and then click on the Design button 
in the database window. You'll see the form design window, where you can modify 
the form . 

2. Click on the Insert Hyperlink toolbar button to open the Insert Hyperlink dialog box. 
3. Leave the box under Link to file or URL: blank. Click on the Browse button after 

Named location in file: (Optional) to open the Select Location dialog box. You should 
see a window like the Database window for the Address Book database. Click on the 
Reports tab, click the name of the labels report, and then click on OK. 
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4. Click on OK in the Insert Hyperlink dialog box. 
S. Notice the underlined reference to the report name you selected in step 4 in the form 

design window. This reference is the hyperlink. Drag the hyperlink to the place you 
want it to appear on the form. 

6. To test the hyperlink, click on the Form View toolbar button. Then click on the hyper. 
link to open the report. When you close the report window, you'll return to the form 
window. 

Adding Command Buttons to a Form 

l #dQ;llfJI 
This Addresses 1 

form has four 
command but

tons and a 
hyper/ink in its 

form header. 
These buttons 
are similar to 

the Preview 
Fact Sheet and 

Dial buttons on 
the Addresses 

form created by 
the Database 

Wizard. 

Let's begin by adding command buttons, like those shown in Figure 3.23, to the 
Addressesl form you created in Lesson 3. 

1. Go to the database window, click on the Forms tab, click on Addresses!, and ther 
click on the Design button on the database window. You'll see the form desig1 
window where you can modify the form . Maximize the form design window t' 
give yourself some room to work. 

2. Move the mouse pointer to the bottom of the Form Header section until it changes t 
an up/down arrow crossed by a bar (shown at left). Then drag the horizontal line at tl1 
bottom of the section downward. This action increases the height of the Form Head1 
so that it is big enough to hold the command buttons. For this example, make tr 
Form Header about .75 inch high. (Look at the vertical ruler, which is marked in 
.25-inch increments, as you resize the form header.) 

lffi Addresses 11!100 13 --------------------------------------
_hlj-'!J~ _!j R~!l0!1ll'J!!ehft !#M 

~ I[• Home Phone (504) 555.9857 

First Name - VVork Phone (?04) sss. 9922 

Last Name D vola Worl' Ext 

Spouse J>;,.J Fax Number (504) 55~· · 7722 

Address 5IJ7 . :!(lh Ave. !;. Birthdate 8/4rt2 
Apt2A 

Send Card No 

coy sea~uo 
Notes 

stateil'rov o/o/A 

Postal Code 98122· Country USA 

Email Number nancyd@anyw l1ere com 

Record 1!.f.:!.J l 



1 

) 

0 

e 
! I' 

e 

... 

LESSON 7: CUSTOMIZING AN APPLICATION I 89 

3. Check to see if the toolbox (shown in Figure 3.24) is visible because you will use it 
to create the command buttons. If the toolbox isn't visible, click on the Toolbox 
toolbar button (shown at left) or choose View >- Toolbox. 

4. Make sure the Control Wizards button is selected (pushed in). You can drag the 
toolbox anywhere you want it on the design window. 

-~-rE 

If the property sheet or another tool is blocking your view in the form design 
:.;,;;;;;;; ..... ~ window, hide that tool by choosing its name from the View menu. 

l''dU;l#fll 
The toolbox lets 

you create 
new objects on 

a form. 

5. Create a command button by clicking on the Command Button tool in the toolbox 
and then by clicking where you want the upper-left corner of the button to appear on 
your form. In this example, click on the left edge of the Form Header (see Figure 3.23). 
The Command Button Wizard dialog box appears. 

6. Click on Report Operations in the Action Categories list (first column) and then 
click on Preview Report in the Action list (second column). 

7. Click on the Next button to continue. 
8. Click on Addresses By Last Name in the report names list in the next dialog box. 

(The Database Wizard built this report automatically when it created the Address 
Book Lessons database.) Click on the Next button to display another dialog box. 

9. Click on Next to accept the suggested button picture. Then the Database Wizard 
asks you to name your button. 

10. Type Addresses by Last Name Button and click on Finish . 

llffh!m18J 
r~ ~ 
.Aa abl 

@pi 

I!IJgj 
...... ~ 
!111M 
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The button appears on the form as shown below. You can't test the button yet 
because it works only when you're in Form view (you're in Design view now). Before 
testing that button, you'll add three more buttons . 

...... .,.. 
To move a button, drag it to a new location . If you want to bypass "grid snap" 
while moving or sizing an object, hold down the Ctrl key while you're dragging. 

Creating the Button for Mailing Labels 
Follow these steps to add a second button to your form: 

1. Click on the Command Button tool in the toolbox and then click slightly to tl 
right of the command button you just created. 

2. Click on Report Operations and Preview Report in the two columns in the m 

Wizard dialog box and then click on Next. 
3. Click on Labels Addresses in the list of available reports and then click on Next 
4. Select (check) Show All Pictures in the next Wizard dialog box. Then scroll up 

Mailbox (the pictures are listed in alphabetical order, by picture name) and click 
that picture name. This step will put a picture of an envelope going through a rr 
slot on the button. 

5. Click on Next. 
6. Type Labels Button and click on Finish. 

Creating the Query Button 
Follow these steps to add a button that will run the query named Addresses Phonel 
Query: 

1. Click on the Command Button tool in the toolbox and then click slightly to 
right of the "mailbox" command button you just created. 

2. Click on Miscellaneous and Run Query in the two columns in the next Wizard di 
box and then click on Next. 



• 

-

1e 

x.t 

to 
on 
.ail 

'st 

the 

alg 

LESSON 7: CUSTOMIZING AN APPLICATION 

3. Click on Addresses PhoneList Query in the list of available queries and then click 

on Next. 
4. Click on Next to choose the suggested picture in the next Wizard dialog box. 
5. Type Addresses PhoneList Query Button and click on Finish. 

Creating the Close Button 
The final button will make it easy to close the form. To create it: 

1. Click on the Command Button tool on the toolbar and then click just to the right 
of the last button at the top of the form. 

2. Click on Form Operations in the first column, click on Close Form in the second col-
umn, and then click on the Next button. 

3. Click on Next to accept the default Exit picture in the next Wizard dialog box. 
4. Type Exit Button and click on Finish in the next Wizard dialog box. 
5. Save your work by clicking on the Save button on the toolbar or by pressing Ctrl+S. 

To align buttons or other objects on the form, select the objects you want to align, 
and then choose Format )oo- Align and an appropriate alignment option. To set 
equal horizontal spacing between objects, select the objects and choose Format )oo

Horizontal Spacing )oo- Make Equal. See Chapter 1 3 for more information. 

Adding Visual Basic Code to a Form 
Next you'll learn how to add some Visual Basic for Applications (VBA) code to your 
form. Please don't think that programming is something you have to do in Access. You 
can create very powerful Access applications with no programming whatsoever. This 
little experiment with Visual Basic serves mainly as a way to get your hands dirty, so 
you can see how programming with VBA works. 

Follow these steps (carefully!) to add some programming code to your form now: 

1. Click on the Properties toolbar button or choose View >- Properties to open the 
property sheet. 

2. Choose Edit >- Select Form. The property sheet displays the properties for the 
entire form. 

3. Click on the Event tab on the property sheet and then scroll down to the On Open 
property. You'll add some code to maximize the Addressesl form window anytime 
you open the Addressesl form. 

0 
! 
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4. Click in the On Open text box, click on the Build ( ... ) button that appears, and 
then double-click on Code Builder. A module editing window will appear with the 
cursor positioned on the blank line between the Private Sub Form_Open and End 
Sub statements. 

5. Press the Tab key and then type exactly: 

DoCmd.Maximize 

as shown below. Be careful to type the text correctly-there's no margin for error 
when you're writing program code. 

Fmm_Addressesl Module l!lllliiEJ 
Object I Form a Proc: lopen 
Private Sub Form Open(Cancel As Integer) 

DoCmd.Maximi~el 
End Sub 

i· ~ 
6. Choose File~ Close (or press Ctrl+W) to return to the form design window. Notice 

that [Event Procedure] now appears as the On Open property. 
7. Scroll down to the On Close propeJty of the property sheet. You'll add some code 

that restores the previously display d window to its original size anytime you close 
the Addresses form. 

8. Click on the On Close text box, click on the Build ( ... ) button that appears, anc 
then double-click on Code Builder. A module editing window will appear with thf 
cursor positioned on the blank line between the Private Sub Form_Close and En< 
Sub statements. 

9. Press the Tab key and then type exactly: 

DoCmd.Restore 

This DoCmd.Restore command restores a window to its previous size. For example 
if you open the Addressesl form from the database window, the database windo\1' 
will reappear at its previous size when you close Addressesl. Likewise, if you open 
Addressesl from the Main Switchboard (as explained later), the Main Switchboar< 
form will reappear at its previous size. 
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10. Choose File~ Close (or press Ctrl+W) to return to the form design window. 
11. Choose File~ Close~ Yes to save and close the modified form. 

You'll return to the database window (press Fll if necessary). 

Customizing the Switchboard Form 

liCfiU;llfJW 
The Switch

board Manager 
lets you create 

new switch
board pages, 
edit existing 

pages, delete 
pages, and 

choose a 
default switch

board page. 

The Switchboard form that the Database Wizard created when you set up the Address 
Book Lessons database provides buttons and options that make it easy to update and 
report on information about your contacts. Since you've gone to the trouble of setting 
up some new forms and reports, you'll probably want to add them to the switchboard. 
You also might want to change the names of options that appear on the switchboard. 

To begin, open the Main Switchboard form and then click on the button next to 
Change Switchboard Items. Or choose Tools~ Add-Ins~ Switchboard Manager from 
the menu bar. You'll see the Switchboard Manager dialog box shown in Figure 3.25. 

Adding the Addressesl Form to the Main Switchboard 
Follow these steps to add your new Addressesl form to the Main Switchboard Page: 

1. Click on Main Switchboard (Default) in the Switchboard Pages list and then click 
on the Edit button in the Switchboard Manager dialog box. The Edit Switchboard 
Page dialog box will appear (see Figure 3.26 for a completed example). 

2. Click on the New button to open the Edit Switchboard Item dialog box. 
3. Type Enter/View Addresses I in the Text box. 
4. Click on the drop-down list button next to the Command box and choose Open 

Form In Edit Mode. A Form box will appear. 

• 
Sw1tchbonrd Managet 

RepoM Switchl:>o•rd 
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litftij:.t#fd 
The Edit Switch

board Page 
dialog box after 
you add a new 
item and move 
it to the top of 

the list. 

Edrt Switchboard Page 

S~chbo111d Name: 

IMern 5wi t~IXJ.,d 

Uetnt on lhl. s, t~hboald: 

nl etNiewAddte~eJ I 
Enl"rNiewAdd!eotes 
Preview Reports 
Change Switchboard Items 
Exit this database 

• 

• 

5. Click on the drop-down list button next to the Form box and choose Addresses I. 
The completed Edit Switchboard Item dialog box looks like this : 

F. drt Switchboard Item 

OK 

Cancel 

6. Click on OK to return to the Edit Switchboard Page dialog box. Your new entry 

appears at the bottom of the Items On This Switchboard list. 
7. Move your n ew item to the top of the Jist by clicking on that item; then click on 

the Move Up button four times. Figure 3.26 shows the completed Edit Switchboard 
Page dialog box . 

...... _ 
If you want to remove the old Enter/View Addresses option from the list, click on 
that item in the Items On This Switchboard list, click on the Delete button, and 
then click on Yes to confirm the deletion. 

8. Click on the Close button to return to the Switchboard Manager dialog box. 
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Changing the Option Names on the Reports Switchboard 
We think the options for printing reports on the Reports Switchboard are a bit verbose 

and maybe even somewhat wordy. If you agree, follow these steps: 

1. Click on Reports Switchboard in the Switchboard Pages list and then click on the 

Edit button. Here's what you'll see: 

Edil Switchboard Page 

llllnl• on tHo s~ d 

f'Jevia"! lhe Faci. Sheel Repool 
Poeview the Biothdays This Monlh Repml 
Poeview the lioeeting Caod List Repmt 
Retum to Main Switchboaod 

Qose 

Hew ... 

EdL 

Qelete 

Move!.!p 

MoveDQwn I 

2. Click on the first item in the Items on this switchboard list and then click on the 

Edit button. The option name will be highlighted in the Text box. 

3. Replace the selected text with Addresses by Last Name Report. To do this task 
quickly, select Preview the (and the space after the) and press Delete. Then click on OK. 

4. Repeat steps 2 and 3 for the second, third, and fourth items on the switchboard 

using the guidelines below: 

• For the second item, change the Text to Fact Sheet Report. 

• For the tl1ird item, change the Text to Birthdays This Month Report. 
• For the fourth item, change the Text to Greeting Card List Report. 

Now add the new Labels Addresses report to the list of items on the Reports Switchboard: 

1. Click on the New button to open the Edit Switchboard Item dialog box. 

2. Type Mailing Labels Report in the Text box. 
3. Click on the drop-down list button next to the Command box and choose Open 

Report. A Report box will appear. 
4. Click on the drop-down list button next to the Report box and choose Labels 

Addresses. 
5. Click on OK to return to the Edit Switchboard Page dialog box. Your new entry 

appears at the bottom of the Items on this switchboard list. 
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6. Click on the Mailing Labels Report item to move your new entry up a notch; then 
click on the Move Up button once. The Edit Switchboard Dialog box will resemble 
the example shown below: 

[dot Switchboard Page 

Items on this Switchboafd: 
1 1\ddreu.,. by Latt Name Report 

F aot S heel Aepool 
Bilthdays T hoo M oorlh Report 
Greetrng Card lnl R 01 

Aeltlrn to Main Swilchboa<d 

New ... 

Q.elele 

~I 

MoveDQWill 

7. Click on the Close button twice to return to the database window. 

Putting It All Together with Startup Commands 
When you open a database, Access looks for certain startup commands and execute~ 

them automatically. You can customize your database by choosing startup commanc 
that hide the database window, go straight to a specific form, and more. The Databa: 
Wizard took care of setting up the essential startup commands for you automaticall 
But let's customize those startup commands just for practice: 

1. Choose Tools >- Startup, or right-click on any tab in the database window a 
choose Startup from the shortcut menus. You'll see the Startup dialog box (a co 
pleted xample appears in Figure 3.27). 

2. Type Address Book Lessons in the Application Title box. (This title will appear 
the Access title bar anytime the database is op n and on Lhe Taskbar.) 

3. Make sure Switchboard appears in the box below Display Form. (You can use the dt 
down list below Di. play Form to choose any form J·bat's available for the Address B 
Lessons database; h wever, using Switchboard gives you the most flexibility.) 

4. Click on OK. The new application title immediately replaces Microsoft Acces 
the window's title bar. 
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The Startup dta
log box after we 

filled in the 
Application Title. 
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• 

Startup 613 

.<IQplication Title: r:Di...;,spl~ay:-,:.E:.._or_m,...: - - ----. 
lAddren Book Lessons l Sw~chboard 

Application !cot>: P Display Qatabase Window 

--=-"'-'"---''~ P Display Status.!lar 
8dvanced » I 

Menu Ba.: .2hortcllt Menu Ba1: 

P Allow F !!H Men us P Allow Built ·in T oolba" 

p , Alloy; Default Shmtcut Menus P'1 Allow Toolbar Changes 

- <»-.- -=:: 
The Main Switchboard form automatically minimizes the database window when 
you open the form; therefore, you don't need to clear the Display Database Win-
dow checkbox in the Startup dialog box. 

Testing the Application 
Now you're ready to test the whole thing. Follow these steps to close and then reopen 

the database: 

1. Choose File)>- Close, or press Ctri+W, until the Main Switchboard form and data
base window disappear. 

2. Open the database you just closed by choosing File from the menu bar; then 
choose Address Book Lessons. 

The Main Switchboard form will open, and you'll see the text Address Book Lessons 

in the Access window's title bar. Now you can explore the Address Book Switchboard 
form to your h eart 's content. When you're finished, do one of the following: 

• To close the Main Switchboard form and the database window, click on the but
ton next to Exit This Database on the Main Switchboard form. 

• To close the Switchboard form but leave the database window open, click on the 

Close button on the Main Switchboard or Reports Switchboard form (or press 
Ctri+W) and then press fll to display the database window. 

When you're done using Access, choose file)>- Exit to return to Windows. Your data

base application will be stored safely on disk for future use. To use the application in the 

future, start Access and open the Address Book Lessons database. 
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At Your leisure 

I 

T learn rn r about reati1~g applications, e Parts F ur and Five of thi book. 

There's More Than 
One Way to Create 
Turnkey Applications 
As you've seen, there's more than one way 
to automate your work and to create turn
key applications with Access. For example, 
you can use a Switchboard form, which 
Access sets up anytime you use the Data
base Wizard, to create a database. You also 

can add hyperlinks, command buttons, 
and Visual Basic programming to forms as 
you did for your Addressesl form. And you 
can use combinations of these and other 
techniques that you'lllearn about in Parts 
Four and Five of this book. Your application 
can be as simple or as sophisticated as you 
wish, depending on your requirements 
and your expertise. It's all up to you! 

Congriltulations! You've just created your first Access database and your first custom 

Access application. The steps you followed to set up the Address Book example also 

work for more than 20 other applications that Access can create automatically. 

If you'd like to build a fancier application now, use the Database Wizard to create an 

Order Entry database (with sample dilta, of course). We'll usc the Wizard-generated Order 

Entry database-with some tweaks to the Wizard-supplied data-to illustrate key con

cepts throughout this book. Alternatively, you can copy our sample Order Entry database 

from the CD-ROM supplied with this boo!' (see Appendix B for details). Having your own 

Order Entry database to experiment with as you read will make learning Access easier ancl 

more fun. 

What's New in the 
Access Zoo? 
You've just taken a look at many of the fea
tures that make Access 97 for Windows 95 
so much easier for beginners to learn and 
use Lhan previous versions of Access were. 

These features include 

• Improved Database Wizards that can 
create more than 20 turnkey applica
tions, complete with sample data. 

• A new way to filter records called Filter 
by Input. 



 



 


